
Release Notes for Beam V3.2.1
New/Changed Features in V3.2.1

The development length calculations for prestressing strand now use fps and fse values taken from the 
point with maximum applied (service) moment. Previously, V3.2.0 used the maximum of these values 
wherever they occurred along the length of the member. This change results in slightly longer 
development lengths and subsequently slightly lower calculated moment capacity at a given point in 
the development region. 

Another small but important change is in the application of the values entered for Design Bearing 
Length on the User Information page and their relationship to the Simple Span value. See item 656 
below for more information.

Bugs Fixed in V3.2.1
694 
698

Ultimate moment calculations for short members with non-symmetric debonding are now correct. 
The development length calculation changes described above along with a change to the prestress 
force calculation in the transfer region were necessary to completely fix this problem. You also 
may see some difference in the development region of non-symmetric pieces without debonding, 
more on the left end than the right end.

656 
737

The Design Bearing Length entered on the User Info page is applied differently now (from 
previous versions) for simply supported members. The Beam V3.2.1 uses the Simple Span value 
as the support-center-to-support-center span and uses 1/2 of the Design Bearing Length value as 
the face of the support for shear calculations.

In previous versions of Beam, simply supported pieces (i.e both cantilever values at 0.0) used the 
full value entered for the Design Bearing Length as the face of the support. That is, the value 
entered for Simple Span was treated as the member length, not the support-center-to-support-
center span. However, values for moment were calculated as if the member had point supports at 
the outside of the bearing, that is, at the very ends of the member.

If you load a problem file from a previous version into Beam V3.2.1, the only difference you'll see 
in the report is the shear value at the face of the support.

Members with cantilevers have always used 1/2 of the Design Bearing Length on each side of the 
support point as the face of the support.

717 In V3.2.0 and earlier, shear values Vci and Vcw were calculated using a prestress steel area value 
adjusted for development from the ultimate moment calculations. Shear calculations now are done 
with a working stress value that reflects losses but not development to ultimate. As a result of this 
change, you will often see an increase in the Vci and Vcw values where strand are beyond transfer 
but still in development.

729 The vertical component of prestress force is now included in the calculation of Vcw. It worked in 
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V3.1.1 but was broken in V3.2.0. See 730 below for related info.

662 
638

Self weight of the member is now calculated correctly when the p/c flange has thickness changes. 
Step changes still are not handled as nicely as we would like (you must use two values with a 
0.01-ft separation but the self weight, applied shear and moment numbers are correct for the 
entered values.

731 The Form Suction and Core Material special loads for stripping conditions are working again. 
They worked in V3.1.1 but were broken in V3.2.0.

725 Overlapping of transfer length from a strand debonded in-span with transfer length from the end 
of the piece is now correctly reflected in the Final Stress calculations. Previous versions over- 
estimated the prestress force (and subsequently the stress) near the end.

636 Ultimate moment is now reported correctly at positions along the member that correspond to the 
edge of an opening in top or bottom flanges.

739 The Zia-Hsu Alternate Torsion Method now includes "<2>NOTE: Section too small..." in the 
Summary of...Reinforcement section of the report when appropriate. In V3.2.0, only the 
Combined Shear and Torsion section noted Section too small.

742 For the Zia-Hsu Alternate Torsion Method, the Sum of X2Y value entered on the Torsion Design 
page is now reported under Miscellaneous Torsion Parameters in the Input Data section of the 
report.

635 
700

Fixed the problem with "Vertical Shear" and "Summary of...Reinforcement" which, for some 
member geometries, prevented the data from being included in the report.

734 The Final Stress section now reports cracked sections with the Intelliprint option selected. 
Previously, only an uncracked section with the highest stresses was reported; cracked sections 
were ignored in the Intelliprint report.

601 
118

If there are rain, snow, wind, or seismic loads specified but no load case includes that load type, a 
message is displayed now. The problem arises because the loads will still be included in the 
working loads used for stress, deflection, and bearing calculations but won't be included in 
factored loads used for ultimate moment and shear calculations.

699 Fixed the problem with window location getting corrupted if you closed Beam while it was 
minimized.

710 The listing of section dimensions and properties in the Design Data section of the report have 
been rearranged to make them easier to read.

715 In the Help > Calculation Methods > Initial Stress about mid page, second paragraph under Eq. 3, 
the max. stress at ends is now correctly given as 6 sqrt(f'ci). It was given as 6 sqrt(f'c).

750 In the Help > Calculation Methods > Combined Torsion and Shear under the Alternate Torsion 
Design (Zia-Hsu), the typo in Eqn. 15 has been corrected.

New unresolved issues in V3.2.1
664 Cracked section analysis ignores mild steel in the compression region. See Example 4 in the 



Release Notes  for Beam V3.2.1                                -   3   -                                                                     05/17/11  

Help. (This isn't really new. It just wasn't on the list before.)

730 Vcw sometimes is wrong when a harp point coincides with a location in the report. The sign on 
the vertical component of the prestress force is reversed. It's usually obvious that Vcw is way out 
of line compared to the values on either side of it. Vcw is seldom the controlling shear value at 
these points.

New/Changed Features in V3.2.0

The big changes for this release are the addition of an ACI 318-05 option for the code provision which 
includes
• strength reduction (φ) factor interpolation in development per Section 9.3.2.7
• an Alternate Method (Zia-Hsu) option for torsion design per Section 11.6.7.

These changes required extensive re-write of Ultimate Moment, Vertical Shear, Torsion, and Summary 
sections of the calculations. Extensive testing has been done to assure that results are as consistent as 
possible with previous versions.

The installer is updated to use MSI, the Microsoft Installer. Because of this, you need to manually 
uninstall any previous version. A previous version and V3.2.0 can co-exist on a system as long as the 
previous version license is valid. After removing the previous version with Add or Remove Programs 
in the Control Panel (or just Programs in Vista) open the Program Files\STI folder and delete the Beam 
folder (not the Beam V3.2.0 folder).

General Changes
608 Updated for use with restricted accounts on Windows Vista and Windows 7. The program now 

stores configuration information in the user's Application Data folder and uses the Temp folder for 
calculation files.

317 The "Override calculated f 'c, f 'ci values" option that was on the Concrete Info page has been 
removed.

544 
631

Full-width openings in flanges are no longer allowed. We realize this will cause some hardship 
when designing spandrels with pass-throughs. It will return in a future update.

Calculation changes
038 
057 
106 
179

The program now handles short pieces of  mild steel at the end of a member correctly. Previously, 
short pieces of mild steel either produced no change in the calculated moment capacity or 
increased it beyond what was calculated for a full-length piece of mild steel.

061 
194

Dead load stresses and sustained load stresses no longer are calculated with the elastic regain in 
the strand stresses. Full live load stresses still contain an elastic regain contribution.

515 Mcr for Ultimate is now calculated without elastic regain.
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403 With Rectangular Stress Block selected, ultimate moment for composite section with different 
unit weight for p/c and topping now uses the ratio of elasticities (which includes a w1.5 term) to 
calculate the compression force in the topping. It was using the ratio sqrt(f 'ctpg / f 'c).

268 
326 
402

The robustness of the algorithms for cracked section properties has been improved, though there 
are still some cases which cause problems. When these algorithms fail, the result is non-
convergence in the Final Stresses and under- or over-flow for Deflections.

431 The value for the Initial Young's Modulus Modifier entered on the Concrete Info page is now 
used as expected. In V3.1.1, the initial value was ignored and the final value was used for both 
initial and final calculations.

466 
543

Shear values are now calculated for cantilevers. However, for user-specified additional points near 
a support, the full value of Vu is reported even if it should be limited to the value at h/2.

467 The "Second run w/ Live Loads Removed from Cantilever" now works reliably. The second run 
report is cleaned up; there is less duplication between runs.

479 
499

A problem with calculated topping width that occurred when the Parabolic Stress Block option 
was chosen on the Concrete Info page has been fixed. The problem caused under-estimation of 
ultimate moment capacity.

514 The value for Stc(tpg) in the report and in the calculations has been changed to Ic/ytpg. It 
previously was this divided by rtpg, the ratio of elasticities for topping and precast. The old value 
was mistakenly used in several places where the new value was really required. See also 592.

516 For '99 code, the over-reinforced strength calculation now includes strand in the compression 
zone.

549 Standard Draping with multiple columns now calculates the correct height for the strand at the 
hold-down.

586 Strand stress-strain curve now uses the Eps entered by the user and, for the PCI Handbook option, 
follows more closely the curve described in Design Aid 11.2.5. See the Help section on Material 
Constants for more information on the new stress-strain curve calculation.

612 Horizontal Shear now uses Equation 11-13 with the minimum enforced for '02 code (and '05 
code). V3.1.1 used Eq. 17.6.1 from the '99 code for all horizontal shear calculations.

675 The φ factor used in bearing stress calculations for the '02 and newer codes is now the value 
entered on the Serviceability page for compression. It was hard-coded at 0.7, which is still true for 
the '99 code.

Report changes
031 
614

The Distributed Loads table no longer displays duplicate lines for Self Weight when flange 
openings or changes in topping thickness are present.

033 The correct value for required precast strength is reported in the Production Info section. 
Previously, the value entered by the user was reported in this section even if it was determined to 
be inadequate.
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035 A note will be included at the Miscellaneous Input Data section when any of the φ factors are 
changed from the default values for the selected code ('99, '02, or '05).

062 A fourth load case is available for '02 and '05 code options.

066 The Light Weight Modifiers on the Concrete Info page are now labeled "Lambda" to clarify their 
actual usage in the calculations.

281 For a General Section with applied negative moment, Mcr is now reported. It was always reported 
as zero in V3.1.1. 

328 Standard Draping will report an error (and stop the calculations) if the hold-down or -up height is 
such that any strand would be pushed out the bottom or top of the piece.

530 A warning is included in the report when mild steel Distance from Bottom is such that the steel 
would be above the precast.

352 When strand do not reach full development because the piece is too short or because of 
debonding, a note is printed in the Ultimate Moment section of the report warning that the 
reported strength may not be achieved. See the discussion in the Help under CM > Design 
Moment, Partially Developed Strand.

417 The note "Temporary stripping conditions were not checked." is no longer printed if Initial 
Conditions are NOT included in the report, i.e. the Initial Stresses box is not checked on the 
Printout Options page.

468 When the check of initial stripping conditions determines that the extreme bottom fiber is never in 
tension during stripping, a note is printed in the Initial Stresses section of the report stating that. 
Previously, the report was silent and it seems that the request for stripping checks simply was 
ignored (though the checks were performed).

460 When "Loads Applied to Top..." is checked on the User Info page, a note is printed with the loads 
in the Input Data section of the report.

464 The Final Stresses section now reports an error when sustained stresses exceed 12*sqrt(f 'c) (or 
whatever multiplier you've specified). The program does not correctly analyze a cracked section 
when cracking occurs with sustained loads.

538 The Horizontal Anchor ... & Bearing Stress section now includes the total torsion which must be 
resisted at support.

582 The notation for torsion equilibrium reaction has been changed to coincide with the notation of 
the PCI Handbook in Fig. 4.5.1.

547 The value for Avci is reported as "Undefined" (Note 3) when the value for Mmax in ACI Eq. 11-10 
is zero.

592 The Stc(tpg) value reported with the section dimensions in the Design Data section of the report is 
now the standard value Ic / ytpg. See also 514.
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User Interface changes
411 You can now save a new (blank) problem file without changes.

235 
432

A CANCEL option was added to the "Do you want to save current problem?" dialog that you get 
when you (e.g.) click on File > Open while you have unsaved changes.

345 When you select the current problem from the File > (list) and have made changes to the input 
data, if you click [Yes] to the question "Do you want to save the current problem?" you will get a 
Save As dialog.

254 
410

You can now view and print the results for problem files that are accessed using the 
\\server\share\path syntax. Previous versions crashed when any of the actions that required 
calculations were requested for files accessed with this path syntax.

270 
324

Clearing the hold-down or hold-up info on the Standard Draping page will remove draping from 
the report even if you forget to change the Holddown Type to "No Holddowns" on the Strand Info 
page. Entering duplicate information for Standard Draping no longer crashes the program.

236 
343 
368

The Help explains the entry requirements for debonding strand better. The confusing little 
inconsistency with X2 between the entry page and the report is noted. The column headings on 
the Debonding page now show "...from left end & middle" and "...from right end" for all display 
resolutions.

350 In the Help on the Final Stresses page (CM), the equations for top and bottom stress are now 
correct. 

351 In the Help on the Tee Sections page (ED), a note was added to remind you about including the 
topping weight as non-composite DL on the Distributed Loads page.

353 The Help explains the bearing steel calculations better.

355 All length dimensions on the Ledge Design page now are entered in inches. Previously some were 
inches and some were feet which caused confusion.

455 A minimum value of 2500 psi has been imposed on f 'c to conform with ACI 318 Section 5.1.1. A 
warning dialog appears if you try to generate a report with a value below 2500 psi for f'c. If you 
continue, a warning is included in the report. 

509 The Help for calculation of horizontal shear reinforcing now correctly defines Vnc as unfactored 
and D as depth of tensile force.

552 The default for the "Loads Applied to Top..." checkbox has been changed to unchecked, the more 
conservative of the two possibilities.

554 The explanations for dw (was ds) and hs (was Hs) have been moved to their proper place on the 
Help page for Torsion Design. They were on the Ledge Design Help page.

575 When entering data on the End Patterns page, the value for the right end (if empty) will 
automatically be entered to match the value for the left end. You can then enter a different value 
for the right end if desired. This saves a little typing and possibly eliminates the opportunity to 
make a error when entering end patterns.
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582 The notation for torsion equilibrium reaction has been changed to coincide with the notation of 
the PCI Handbook in Fig. 4.5.1. This is reflected in the labels on the Torsion Design page and the 
Help for Entering Data and Calculation Methods.

583 Beam now uses the folder designated in by the environment variable APPDATA  for the 
configuration files Beam.ini and Beam.hst. The folder designated by the environmental variable 
TEMP is used for temporary intermediate files.

587 The Help now gives a more detailed explanation of the strand stress-strain curves used by Beam. 
See the Material Constants page of the Calculation Methods.

624 The dimensions for General Section are explained better in the Entering Data section of the Help.

Unresolved Issues

013 If you define an opening for a beam type then change to general section, you will get a message 
"can't have openings in g-sect" when you try to generate a report.

052 The transfer length for strand should be calculated following equation 12-2 of ACI 318-02. 
Currently the program uses 50 strand diameters for the transfer length.

047 Help needs to be improved for hollowcore. See 176 below.

176 Hollowcore example from James to be included in the Help. See 047 above. He uses an I-section 
for hollowcore; not sure we want to endorse that.

065 
640

Truncated output for symmetrical members not working (with added points). Truncation doesn't 
work at all in Vertical Shear.

085 Requirement for hanger steel for ledge beam with unbalanced loads seems high. See also 117.

117 Hanger steel calcs don't match what she gets from the equations in the Help.

086 New info on strand development to be incorporated.

119
145

Add service load multipliers for stresses and deflections.

121 In some cases, shear Avmin shows note 1 when stress is 55%.

146 When an application hits a dead end during calculations, it should pass a flag back to the UI so 
the user can be notified instead of having to look for a "WARNING>>>" in the output.

151 Wants Mu reported in ft-kips.

163 Final deflections with 100% sustained live load: why aren't the two numbers the same?

207 Wants chamfers for double tee sections.
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209 For beam sections, only the dimensions that apply for the section type should be active. For 
example, a rectangular beam shouldn't have top and bottom flange dimensions.

234 Need a check for effective flange width, ACI sect 8.10 ('05).

469 Calculate shear using strength for p/c and topping.

322 
521

Report strand losses at transfer length and at critical section(s).

535 Warning depends on printout options. That is, when a section of the report is unchecked on the 
Printout Options page, some warnings that would normally appear for those calculations are not 
displayed.

296 
646

Break out wind and seismic loads for deflections and only include load types that are entered.

312 Program should indicate when self weight is calculated from section properties and when it is 
entered by the user.

346 Special Moving Loads should be disabled when the member has a cantilever.

532 Remove the curve in strand development calculation; i.e. use the linear segments as shown in 
current PCI Handbook.

557 fpc factor for Vcw is calculated differently from PCA notes.

574 Should flag Loads Applied to Top for L- or IT-beam types.

637 Skip Awv, Awl when there is no torsion.

648 Avmin for p/c pieces (strand dia, area = 0.001) is calculated with the prestress equation (ACI Eq 
11-14).

263 Print shape factor for bearing pad.

309 Maximum load envelope does not consider negative (uplift) loads when they fall into different 
load cases.

310 Add a button to the Toolbar that activates the context sensitive Help.

313 All values that the user can leave at zero so the program will use defaults or calculate a value 
should be identified on the input pages with something.

560 Add a button to locate warnings in View Results so the user doesn't have to search for them.
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331 
641

Allow holes and taper in flat slabs modeled as an R-beam.


